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Warranty disclaimer 

All information in the present documentation was prepared and compiled with great care and reproduced 
in accordance with effective control measures. No warranty is provided for freedom from errors. We 
reserve the right to make technical changes. The present information as well as the corresponding 
technical data can change without notice. Reproduction of any part of this documentation or its 
processing or revision using electronic systems is prohibited without the manufacturer’s prior written 
approval. 

Components, devices and measurement sensors made by burster präzisionsmesstechnik (hereinafter 
referred to as the “product”) are the result of targeted development and meticulous research. From the 
date of delivery, burster provides a warranty for the proper condition and functioning of these products 
covering material and production defects for the period specified in the warranty document accompanying 
the product. However, burster waives any guarantee or warranty obligations or any additional liability for 
consequential damages caused by improper use of the product, in particular the implied guarantee of 
success in the market as well as the suitability of the product for a particular purpose. Furthermore, 
burster assumes no liability for direct, indirect or incidental damages or for consequential or other 
damages arising from the provision and use of the present documentation.  
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1 Symbols used in the operation manual 
1.1 Signal words 
The following signal words are used in the operation manual according to the specified hazard 
classification. 

 

 
DANGER 

High degree of risk: indicates a hazardous situation which, if not avoided, will result in death or 
serious injury. 

 
WARNING 

Moderate degree of risk: indicates a hazardous situation which, if not avoided, may result in death or 
serious injury. 

 
CAUTION 

Low degree of risk: indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury. 

 NOTICE 
 

Note: It is important to heed these safety notices in order to ensure correct handling of the sensors. 

IMPORTANT: Follow the information given in the operation manual. 

1.2 Pictograms 

 
Electric shock hazard. 

 
Observe the advice for protecting the instrument. 
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2 Introduction 
IMPORTANT: Read the operation manual carefully before using the equipment, and keep it for future 

reference. 

2.1 Intended use 
The DigiVision software can be used to configure various burster sensors and devices, and to carry out 
measurements. This operation manual relates exclusively to torque sensors. If using other sensors or 
devices, please refer to the respective operation manual. 

2.2 Customer service 
2.2.1 Customer service department 
If you have repair inquiries or software problems, please call our customer service department on 
+49 7224 645-53. 

2.2.2 Contact person 
If you have any questions, please contact your representative or go directly to burster 
präzisionsmesstechnik gmbh & co. kg. 

Headquarters 

burster präzisionsmesstechnik 
gmbh & co kg 
Talstrasse 1 - 5 
76593 Gernsbach 
Germany 

Phone:   +49 7224 645-0 
Fax:  +49 7224 645-88 
Email:  info@burster.de 
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3 Non-rotating torque sensors, model 
8625/8630/8631, USB version 

3.1 Electrical connection 

 

 NOTICE 
The USB socket is supplied with a protective dust cap fitted. Before putting the sensor 
into use, this cap must be levered off, without damaging it. It is not meant to be cut off! 

 

 
1. Take the cap off the USB socket.  

 
2. Connect the torque sensor to a computer using the supplied USB cable. 

3. Please be sure to follow the instructions in section 3.2 Power supply on page 7. 

3.2 Power supply 
The device draws 200 mA from the USB port. Usually this is not a problem for desktop PCs. 

For laptops, however, several USB ports may share one power supply that is additionally loaded by other 
connected USB devices (mouse etc.) Therefore, under some circumstances, the torque sensor may be 
supplied with too little power and cannot register its presence. In this case, you need to connect the 
torque sensor to the laptop via an active USB hub. 
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3.3 Connector pin-out 
The USB interface complies with the USB 2.0 standard and the pin assignment is as usual. The built-in 
connector on the torque sensor is for a “Micro USB” plug. 

Pin Name  

 
Figure 1: Micro USB [mm] 

1 +5 V 

2 Data - 

3 Data + 

4 ID (not used) 

5 GND 

 

The connector fitted on the supplied cable is a “USB Type A” plug. 

Pin Name 

 

 
Figure 2: USB A [mm] 

3.4 Ground connection 
The common ground connection “Digital Ground GND” is shared by: 

• USB plug casing 

• Shield  

• Sensor housing 

• Protective ground 
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Figure 3: Ground connection 

3.5 Running cables 
In general the following applies: 

• The torque sensor must be grounded via its mounting screws. 

• The USB cable length should not exceed 2 m. For longer cables it may be necessary to 
connect an active USB hub in the cable link to avoid losing the USB connection. 
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4 Rotating torque sensors, model 8655/8656/8661, 
USB version 

4.1 Electrical connection 
The USB socket is supplied with a protective dust cap fitted. Before putting the sensor into use, this cap 
must be levered off with a suitable tool, without damaging it. It is not meant to be cut off! 

 
1. Carefully prise off the protective cap using a pointed tool. 

 
2. Take the cap off the USB socket. 

 
3. Connect the torque sensor to a computer using the supplied USB cable. 

4. Please be sure to follow the instructions in section 3.2 Power supply on page 7. 

5. The torque sensor goes through a self-test mode lasting 4 seconds after power-up. 
Once the self-test has finished, all the LEDs – if fitted – light up solidly for about 1 s. 
Then the sensor is ready for operation. 
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4.2 Power supply 
After the torque sensor is connected to the USB port, the sensor identifies itself as a “high power device”. 
In this case, the device draws 495 mA from the USB port. Usually this is not a problem for desktop PCs. 

For laptops, however, several USB ports may share one power supply that is additionally loaded by other 
connected USB devices (mouse etc.) Therefore, under some circumstances, the torque sensor may be 
supplied with too little power and cannot register its presence. In this case, you need to connect the 
torque sensor to the laptop via an active USB hub. 

Note: The actual power consumption is: P = 5 V * 0.35 A = 1.75 VA. 

4.3 Connector pin-out 
The USB interface complies with the USB 2.0 standard and the pin assignment is as usual. The built-in 
connector on the torque sensor is a “USB Mini B” plug. 

 

Pin Name  

 
 

Figure 4: USB Mini B [mm] 

1 +5 V 

2 Data - 

3 Data + 

4 ID (not used) 

5 GND 
 

The connector fitted on the supplied cable is a “USB Type A” plug. 

Pin Name  

 
 

Figure 5: USB A [mm] 

1 +5 V 

2 Data - 

3 Data + 

4 GND 

  

4.4 Ground connection 
The common ground connection “Digital Ground GND” is shared by: 

• USB plug casing 

• Shield  

• Sensor housing 

• Protective ground 
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Figure 6: Ground connection 

4.5 Running cables 
In general the following applies: 

• The torque sensor must be grounded via its mounting screws. 

• The USB cable length should not exceed 2 m. For longer cables it may be necessary to 
connect an active USB hub in the cable link to avoid losing the USB connection. 
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5 DigiVision software 
5.1 Device list / Device detection 

 
1. Open DigiVision. 

2. Go to “File” > “Find devices…”. 

 
3. As soon as the torque sensor has been detected, it is displayed under the associated 

port. 

 

5.2 Device settings 
You can access the “Device settings” menu from the DigiVision device list. 
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1. Open the device list in DigiVision. 

2. Select the torque sensor and click “Parameterization”. 

 
3. You can now configure the sensor-specific settings. 
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5.3 Setup 
5.3.1 Setting up rotating sensors 
On the “Settings” tab, you can specify the units and conversion factors to be used for the relevant 
measurement channels. Units suitable for the measured variable should be selected, otherwise errors 
may occur when displaying the measured value and in its interpretation. 

With “Number of Averages” you can set the number of individual measured values to be used to form an 
arithmetic mean. The value can be set in the range N = 1 to N = 20. When N = 1, averaging is not 
performed. In this case, the value at the output is refreshed every 10 µs. This corresponds to 100 000 
digitizations per second. So if you select N = 20, for example, then a measuring time of 200 µs is needed 
for a new value at the output (20 x 10 = 200 µs). The averaging has a direct effect on the measured 
values per second. The higher the averaging value, the fewer measured values per second are possible. 

 

If the torque sensor includes the speed/angle measurement option, you can switch between these two 
measurement modes on this tab. 

If the torque sensor is the optional dual-range version, you can also select the required measurement 
range here. Applying the settings saves them in the sensor. 

 
Figure 7: Settings for rotating sensors 
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5.3.2 Setting up non-rotating sensors 
On the “Settings” tab, you can specify the units and conversion factors to be used for the relevant 
measurement channels. It is important to select units that make sense and are suitable for the measured 
variables, otherwise errors may occur when displaying the measured value. 

With “Number of Averages” you can set the number of individual measured values to be used to form an 
arithmetic mean. The value can be set in the range N = 1 to N = 50 000. When N = 1, averaging is not 
performed. In this case, the voltage value at the output is refreshed every 10 µs. This corresponds to 
100 000 digitizations per second. So if you select N = 50 000, for example, then a measuring time of 
5 seconds is needed for a new voltage value at the output (50 000 x 10 = 0,5 s). The averaging has a 
direct effect on the measured values per second. The higher the averaging value, the fewer measured 
values per second are possible. 

Disable the low-pass filter if you set a value N ≠ 1. 

Filter settings: Set the averaging value to N = 1 if you select a cut-off frequency ≠ OFF. 

The low-pass filter is a digital filter designed as a first-order low-pass filter. 

Apart from the “OFF” setting, you can select various cut-off frequencies. The cut-off frequency is the 
frequency at which the output signal is attenuated by -3 dB, corresponding to about 70.7 % of the signal 
at very low frequencies. 

If the torque sensor is the optional dual-range version, you can also select the required measurement 
range here, or activate switching by a voltage level. 

Applying the settings saves them in the sensor. 

 
Figure 8: Settings for non-rotating sensors 
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5.4 Limits 
The “Limits” tab is where you can set the sensor limits you require. Select the level for the limit, the 
channel reference for this limit and whether you wish to monitor the measurement signal for ≥ or ≤. 

 
Figure 9: Limits 

5.5 Properties 
The “Properties” tab contains information about the torque sensor being used. This is where you can find 
the software version, device type, serial number, device option and calibration date. You can also add 
comments for documentation purposes. 
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Figure 10: Properties 
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6 Properties, measurement rate etc. 
You can use the “Properties” button to make additional general settings. For instance you can set the 
measurement rate for the torque sensor here. 

 
1. Open the device list in DigiVision. 

2. Select the torque sensor and click “Properties”. 

 
3. You can now configure additional general settings. 

6.1 General settings 
The “General information” tab contains general information about the torque sensor being used. You can 
also enter a station name for the torque sensor, i.e. a name identifying the device. 
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Figure 11: General settings 
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6.2 Measurement mode and data acquisition 
Different measurement rates (sampling rates) can be selected. The maximum number of 
measurements/second is determined by the number of averages and the license. 

 
Figure 12: Measurement mode data acquisition for non-rotating sensors 

 
Figure 13: Selecting the measurement rate and acquisition mode for rotating sensors 
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Two different acquisition modes are available. Different measurement rates (sampling rates) can be 
selected depending on the acquisition mode. 

Normal 
Measurement rates of between 0.1 and 20 measurements per second are possible here. 

SPOM (Speed optimized POlling Mode), only available with model 8661 
Measurement rates of between 0.1 and 1000 measurements per second are possible here. 

Angle display (only available with rotating sensors) 
The “Measurement mode” tab also lets you set how you want to display the (optional) angle reading: from 
0 to 360° or continuously without limit.  

 

6.3 Measurement mode settings 
In DigiVision, numerous different settings can be made for the measurements. You can access the 
Settings menu directly from the “Measurement mode” function. 

 
1. Open DigiVision. 

2. Select the “Start measurement mode …” item in the device overview. 

 
3. Press the “Options” button. This opens the “Basic configuration” window. 
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6.4 Basic configuration 
On the “Basic configuration” tab, you can specify how many channels you wish to display. You can also 
make various settings here for the display and presentation of the measurement curve. 

 
Figure 14: Basic configuration 
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6.5 Channel settings 
The “Channel settings” tab is where you can set specific parameters for each measurement channel. 

 
Figure 15: Channel settings 

The default setting is to adopt the parameters from the torque sensor, although you can also make 
manual changes to any parameter. Here you can also define the limits, measurement curve colors and 
the colors and shapes of the symbols that can be shown in the graphs. You have to make these settings 
separately for each measurement channel. 

6.6 Trigger 
Measurement can also be stopped using a trigger with a suitable stop condition. 
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Figure 16: Trigger settings 

6.6.1 Repeat measurement after time interval 
You can use the “Repeat measurement after time interval” setting to specify a time interval after which a 
repeat measurement shall take place following the end of a measurement process. You can configure the 
settings to apply to all channels or each channel individually. 

6.6.2 Start-trigger setting 
Here you can define the start condition. 

6.6.3 Stop-trigger setting 
Here you can define the stop condition. 

6.6.4 Recording in a range 
You can use this setting to specify the range of values within which a measurement shall take place. 

6.7 Documentation 
Various documentation settings are available here. For instance you can define various counter settings, 
which can be common to all channels or apply to specific channels. You can also enable/disable the 
documentation setting. 
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Figure 17: Documentation settings 

6.8 Display 
The measurement curves are displayed in a line graph separately for each measurement channel. The 
measured values are plotted against measurement time in this graph. 

You have various zoom and display options available to gain a better view. For instance you can 
show/hide measurement channels. 

Maximum and minimum values (Max, Min) are shown in the area to the left of the graph. You can reset 
these values using the “R” buttons. 

The “T” button tares the current value; the tare value is displayed next to the button. Pressing the button 
again clears the value. 
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Figure 18: Display showing the measurement curves for torque, speed and mechanical power 

In the Standard or Professional multi-channel software versions, you can switch between different views. 

 
1. Click on “full screen” to get a larger view of the measurement curve. This enlarges the 

individual graph to full screen size during the measurement process. 
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2. Click on “Normal” to revert to the standard view. 

 

6.9 Start and stop measurement 
To start a measurement with DigiVision and a connected torque sensor, follow the steps below: 

 
1. Select the torque sensor in the device list and click “Start measurement mode...” under 

“Measure” in the left-hand menu bar. 
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2. Click on “Start measurement” or press [F4] to start displaying the values, or [F5] for 
recording. 

 
3. During the measurement process, the instantaneous measured value and minimum 

and maximum values are displayed and updated at the set measurement rate. Click 
on “R” or press [F6] to reset the maximum or minimum values, “T” or [F7] to tare the 
current value. 

4. To stop measuring, click “Stop measurement” or press [F8]. Measurement can also be 
stopped using a trigger with a suitable stop condition. For more information on the 
trigger function, see section 6.6 Trigger on page 24. 

6.10 Measurement reports 
Note: If you wish to save the raw data for the measurement data reports, before starting measurement 

you must tick the “Save raw data measurement files” under “Preferences” > “Data storage”. 

6.10.1 Measurement report finder 
DigiVision has a convenient archiving feature for measurement reports. It lets you save all measurements 
that have been made, and then retrieve them again as required. You can use the “find reports” feature to 
perform the following actions for one or more reports: view, analyze, print, save as a PDF document or 
export to an Excel file. 
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1. To access the report search, click on “Measure” in the left-hand menu bar and then on 

“Find and manage measurement reports”. 

 
2. Here you have a choice of two different report types: measurement report or group 

report. 
A measurement report displays each individual physical variable (M, α , n, P), which 
are presented as one measurement sequence. 
A group report is a report that contains all the measurement sequences. The individual 
measurement reports that were involved in the measurement are recorded here. This 
makes it easier to assign the measured variable. 
Select the report type you require. 

3. Various filters such as device type, date and channel number can be used to reduce 
the number of measurement reports displayed for a clearer picture. Left-click on the 
measurement report you want to select. If you want to select more than one 
measurement report, hold down the [CTRL] key while selecting multiple reports. 

4. Once you have selected the measurement reports, click “Open”. 
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6.10.2 Archive viewer 
Once you have selected the measurement reports from the Find reports window, the Archive viewer 
opens. This gives you detailed information on your measurement. The Archive viewer is also the 
management center for viewing and editing measurement reports. 

 
Figure 19: Archive viewer 

 
1. To view each measurement report separately, left-click on the desired measurement 

report. 

2. To group together several measurement reports, i.e. to superimpose the measurement 
curves in one graph, press the [CTRL] key while left-clicking on the measurement 
reports you wish to display. 

6.10.3 Export measurement reports to Excel 
Note: To export the measurement reports in the Excel format you will need Microsoft Excel or an 

equivalent piece of software. 

 
1. Once you have selected the measurement reports you click on “Export” to export an 

XLS file. 

2. Specify whether you wish to export all the reports or just those you have selected. 

3. Specify the path to the directory in which you wish to save the file. The default setting 
is to save the XLS files in the same directory as the measurement reports. You can 
also specify an alternative path here. 
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4. Click “Next”. 

5. The data is converted and saved in the specified directory.  

6.10.4 Print measurement reports 

 
1. Once you have selected the measurement reports you click “Print”.  
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2. Select how you want the measurement reports to be printed. 

3. Click “Next”. The Print Options window opens. 
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4. Now specify how you want the data to be output. You have the option to choose a 
printer, print preview or output as a PDF document. 

5. Click on “Start”. 

6. The data is output according to your settings. 
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7 Installing DigiVision 
7.1 System requirements 

Item Manufacturer / description 

Operating systems Windows Server 2003, Windows XP, Windows 7, Windows 8, Windows 10 

Processor At least Pentium 1200 MHz, Pentium 2.0 GHz recommended 

Graphics card At least VGA 800 x 600; at least 256 colors 

Memory At least 2048 MB RAM 

Hard disk Approx. 500 MB free 

Input devices Microsoft-compatible mouse, standard keyboard 

Font setting Small fonts 

7.2 Software installation 
IMPORTANT: To install DigiVision, the user needs to be logged in as an administrator. 

 
1. Download the latest version of DigiVision from our website and unzip the package. 

2. Run Setup.exe and follow the instructions of the installation routine. 

7.3 Driver installation 
If DigiVision has been installed, it is not necessary to install the drivers separately. If you want to install 
just the drivers, e.g. if LabView is used, please install the burster Instrument drivers. The driver package  
can be found in the download area on our website. 

IMPORTANT: To install the driver, the user needs to be logged on as an administrator. 

 

 

 

7.4 Data storage 
In order to be able to store the raw data from measurements carried out, you simply need to enable the 
option “Save raw-data measurement files” once before starting the measurement. 

 
1. In the DigiVision device list, click on “Edit” > “Preferences“ > “Data storage”. 

2. Tick the checkbox for “Save raw-data measurement files” and click “OK”. 
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8 Software version and licensing 
8.1 DigiVision Light 
The USB torque sensor is supplied with the free DigiVision Light configuration and analysis software. This 
version provides the following functions: 

• Measurement function for one sensor 

• Maximum sampling rate of 200 measured values per second 

• Display of angle or speed (for relevant sensor model) 

• Calculation of mechanical power (only with the angle or speed measurement option) 

8.2 86xx-P100, Standard version 
An upgrade from the DigiVision Light version to the Standard version (86xx-P100) can be purchased as 
an option (license key). In comparison to the Light version, the Standard version includes the following 
extra functions: 

• 16-channel measurement for up to 16 sensors in parallel 

• Maximum sample rate of the sensor possible 

In the multichannel versions, you can switch between different views (for further details see section 
6.8 Display on page 26). 

 
1. Click on “full screen” to get a larger view of the measurement curve. This enlarges the 

individual graph to full screen size during the measurement process.  

2. Click on “Normal” to revert to the standard view (see section 6.8 Display on page 26 
for details). 

8.3 86xx-P200, Professional version 
The DigiVision Professional version (86xx-P200) is available as an upgrade for DigiVision Light or 
Standard. In comparison with the Standard version, the Professional version includes the following extra 
functions: 

• Additional user-configurable mathematical channels. 

• 32-channel measurement for up to 32 sensors in parallel 

See below for an example of how to configure an additional mathematical channel. Simple calculations 
such as calculating the efficiency or difference speeds and also complex mathematical operations can be 
performed. 

 

8.4 Licensing 
To activate the DigiVision Standard or Professional version, follow these steps: 

 
1. In the top menu bar, click Help > Licensing. 
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2. Enter your license key. The license key could look like this:  

12345-12345-12345-12345. Make sure that you enter the license key exactly as it 
appears in your license documents. 

 
3. Click “Activate License”. When the correct license key is entered, the corresponding 

device type is activated. If the license key is invalid, the licensing process is 
terminated. 

8.5 Uninstall 
Follow these steps to uninstall the software: Go Start > Settings > Control Panel, open the Programs 
group and select the “DigiVision” entry in the installation list. You can then uninstall the application by 
selecting “Add/Remove” and “Remove program” in the installation routine. 
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9 Disposal 

 

Battery disposal 
In Germany, the end user is legally obliged to return all used 
batteries, and it is illegal to dispose of batteries in the household 
waste. This law may also affect you as purchaser of the instrument 
described here. Please dispose of your used batteries properly and 
in accordance with national statutory regulations. Either take them 
to the relevant collection point in your organization or to the 
collection points provided by your local authority, our company or 
any battery retail outlet. 

Instrument disposal 
If your instrument is no longer usable, please comply with your legal 
obligations by disposing of the instrument described here in 
accordance with statutory regulations. You will then be helping to 
protect the environment! 

 


